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Overview of Inspiration®

Inspiration® integrates dynamic diagramming and outlining environments to help you organize ideas and information. Easily create and modify concept maps, webs and other graphical organizers using Inspiration’s Diagram view. An intuitive interface keeps your focus where it should be — on your ideas, not the drawing process. Inspiration’s powerful Outline view makes it simple to prioritize and rearrange ideas to create clear, concise essays, reports and more.

Trying Inspiration, a step-by-step guide

In this tutorial you will use Inspiration to perform a common brainstorming and planning task — picking a place to go for your family vacation. Remember that this is just one of the many ways Inspiration can work with thoughts and ideas. When you purchase the full version of Inspiration, you’ll receive the Inspiration Getting Started guide and User’s Manual, which contain more information

Entering your main idea

When you start Inspiration, you’re in Diagram view. We’ll

begin this tutorial as you begin any Inspiration diagram—by entering text in the Main Idea symbol. The Main Idea symbol appears in the center of your screen, with the placeholder text, Main Idea, already selected. All you do is type.[image: image1.png]



1 Type your main idea—Family Vacation.

2 Press (Shift+Enter) to end text entry and select the symbol.

Adding ideas to your diagram

As part of our planning, we’re going to enter what each family member wants to do on vacation. First, we’ll add the idea symbol What we want to do. Then we’ll add an idea symbol for Mom.

Use the Create tool to add an idea

1 With Family Vacation selected, on the Diagram toolbar, position the pointer over the Down arrow on the horizontal and vertical Create button.[image: image2.png]



When you point to an arrow on the Create button, it is highlighted to show you the direction in which the new idea symbol will be created.

2 Click the Down arrow.

The new symbol appears connected to and below the Family Vacation symbol.

3 Type What we want to do.

4 Now add a symbol for Mom. On the Diagram toolbar, position the pointer over the Lower Right Diagonal arrow on the diagonal Create button.[image: image3.png]Create




5 Click the Lower Right Diagonal arrow.

The new symbol appears connected to and diagonally below the What we want to do symbol.

6 Type Mom.

7 Press (Shift+Enter) to end text entry.

8 Select What we want to do again.

9 Click the Lower Left Diagonal arrow.

10 Type Dad.

11 Press (Shift+Enter) to end text entry. Let’s take a look at what you’ve created so far:
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Tip… You can use the Position tool to reposition your diagram in the window. It’s useful when you want some space where you can add more symbols. Just click the Position button, then click and drag the diagram until it’s positioned where you want it. Click the Position button again to turn it off.

Using the RapidFire™ tool

We’re going to use Inspiration’s RapidFire tool to enter the things Mom wants to do while on vacation. You use RapidFire when you want to brainstorm, capturing your ideas quickly without worrying about their order. You add ideas right into the selected symbol, letting Inspiration create new symbols for your ideas.

1 Click the Mom symbol to select it. On the Diagram toolbar, click the RapidFire button. The RapidFire icon appears in the symbol to show you the tool is turned on. You’re ready to begin typing ideas. 

2 Type Sun, then press (Enter). Once you start working in RapidFire, you use the (Enter) key to separate your ideas.

3 Type Scuba.

4 Click the RapidFire button to turn it off.

Now let’s add Dad’s preferences

1 First, select Dad and drag him to the left two inches to give yourself more space to work with.

2 With Dad selected, on the Diagram toolbar, click the RapidFire button.
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The RapidFire icon appears in the symbol to show you the tool is turned on. You’re ready to begin typing ideas.

3 Type Play golf, then press (Enter).

4 Type Fish.

5 Click the RapidFire button to turn it off.

Now let’s take a look at your work

Here’s what your diagram looks like so far.
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RapidFire places your ideas in a freeform structure. You don’t need to think about organizing your ideas yet—you’re still getting them down so you can ‘see’ what you think. We’ll learn about organizing the diagram later in this tutorial.

Aside… If you see that you’ve made a mistake while typing text in a symbol, don’t worry. It’s easy to fix. Double-click the text in the symbol, then select the words you want to change and type over them. You can also insert text by clicking where you want to make the correction and entering the new text.

Changing the view scale

It’s helpful to zoom in and out when you’re working on your diagram. Sometimes you want to take a closer look at a section; at other times, you want to see more of your diagram in the window.

1 On the scroll bar at the bottom left of the window, click the Zoom Out button.
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Drag and drop to add symbols

Inspiration has hundreds of symbols you can use in your diagram. Here, we’ll add one of the six basic symbols, the rounded rectangle, to the diagram using drag and drop.

1 On the Symbol palette, locate the rounded rectangle symbol.
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2 Click and drag the symbol until it’s positioned below the Fish symbol and slightly to the left, then release the mouse button. When you add a symbol using drag and drop, the symbol is not connected to any other symbols. You can link it later using the Link tool on the Diagram toolbar.

3 Type Marlin in the new rounded rectangle symbol.

Adding unconnected ideas

Sometimes when you’re working you want to add an idea, but you’re not sure right away where it fits. You can easily add an unconnected idea anywhere on the diagram with Inspiration’s point and type method. For now, let’s add an idea symbol on the diagram to represent Sarah, another member of the family.

1 Click in the open area on your diagram under the Scuba symbol, then type Sarah. A symbol pops up to hold the Sarah text. The symbol isn’t linked to any other symbol.

2 Click away from the Sarah symbol to deselect it.

Link the unconnected symbols to show how they relate to other ideas

We’ll link the What we want to do symbol to the Sarah symbol so that we can include Sarah’s ideas in our planning. To show that Fish and Marlin are related, we’re also going to draw a link that connects those two idea symbols.

1 On the Diagram toolbar, click the Link button.[image: image9.png]



The cursor becomes a two-headed arrow.

2 Click the What we want to do symbol to tell Inspiration where you want to draw the link from (the primary symbol).

3 Click the Sarah symbol to indicate where you want to draw the link to (the secondary symbol).

The link appears, connecting the primary to the secondary symbol. The arrow head points to Sarah to show that it’s an offshoot of the What we want to do idea symbol.

Now let’s link the other unconnected symbol, Marlin, with the idea symbol, Fish.

4 Click the Fish symbol to tell Inspiration from where you want to draw the link (the primary symbol).

5 Click the Marlin symbol to indicate to where you want to draw the link (the secondary symbol). The link appears, connecting the primary to the secondary symbol.

6 Click the Link button again to turn it off.

Add text on the link

You can add text on a link to describe the relationship between the linked ideas. Here, you will add the word for so it’s clear that the connection is that Dad wants to fish for marlin.

1 Select the link that connects Fish and Marlin, if it isn’t already selected. When the link is selected, you see the outline of the text box area on the link. It’s ready for you to begin typing.

2 Type for, then click outside of the diagram to deselect the link.

Move idea symbols around

Moving symbols is easy. Here, you will reposition the Marlin symbol so that it’s a bit lower on the diagram.

1 Click and drag the Marlin symbol down about one inch and release the mouse button, then click outside of the diagram to deselect the symbol. If you need to move the symbol again to position it to your satisfaction, just click and drag it again until it’s where you want it. Notice how Inspiration keeps the link connected for you as you move the symbol. That way, you don’t lose the connection between ideas when you move them around on your diagram.

Changing symbol shapes

Here, we’ll make a section of the diagram stand out by changing the shape of the symbols. In this case, we’re going to select Dad and his vacation preferences and change these symbols all at the same time to make them easy to identify. 1 To select the symbols, hold down the Shift key and click Dad, Fish, and Play golf.

2 On the Symbol palette, click the rounded rectangle symbol. The selected symbols take on the new shape.
 Working in Outline view

Inspiration has two views or environments in which you can work, a Diagram view and an Outline view. While you have been working in Diagram view creating a visual diagram, Inspiration has been building an outline of your work.

Switch to Outline view

1 On the Diagram toolbar, click the Outline button.[image: image10.png]Outiine




Your diagram appears as an outline. The idea symbols you added in Diagram view appear as topics and subtopics. Your link text does not appear as part of your outline, but it is available in Diagram view.

The + next to the Mom topic indicates the topic has subtopics. The - next to the Sarah topic indicates the topic has no subtopics.

Add a subtopic

Adding ideas in the Outline view is as simple as adding an idea symbol in Diagram view.

1 Select the topic Mom by clicking to the left of the topic prefix.

2 On the Outline toolbar, click the Add Sub button.[image: image11.png]add Sub.





A new subtopic is created below Mom. It’s indented one level in your outline.

3 Type Swim.
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Add a topic

Now we’re going to add Snorkeling.

1 Select the topic Sarah by clicking to the left of the topic prefix.

2 On the Outline toolbar, click the Add Topic button. Inspiration inserts a new topic and the cursor moves to the next line so you’re ready to 
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3 Type Snorkeling.

Change the level of a topic

In Outline view, you can move a topic to the right or to the left, changing its level of importance. Snorkeling is something Sarah really wants to do, so let’s change the Snorkeling topic to a subtopic under Sarah.

1 On the Outline toolbar, click the Right button. [image: image14.png]



The topic, Snorkeling, moves to the right, so that it’s now a subtopic to Sarah.
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Add notes text to a topic

Adding notes text is a good way to elaborate upon your ideas. As you add more notes, you develop your outline into a complete written document. Let’s add a note to the topic Snorkeling.

1 With Snorkeling selected, press (Enter). The cursor moves to a new line so you can type in your notes.
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2 Type Sarah would like to go out in a boat to do this.

Each topic can have notes that extend from one line to many paragraphs of information. If you add notes to your topics, you will end up with a written report when you finish. Whenever you add notes text to a topic, Inspiration puts an outline around the + or - in front of the prefix. It looks like this:
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Tip…You can also add notes text by selecting a topic and clicking the Add Note button on the Outline toolbar.

Hiding subtopics

When you’re working with a complex outline, you’ll want to hide and show subtopics. Hiding the detail in your outline makes it easier to see its overall structure. We’ll hide the subtopics for the Dad topic.

1 Click to the left of Dad to select the topic.

2 On the Outline toolbar, click the Show/Hide Sub button.
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Inspiration hides the subtopics for the selected topic, so there’s less detail showing on your outline.

3 On the Outline toolbar, click the Show/Hide Sub button again or double-click to the left of the topic prefix to show the subtopics.

Note... Just as you can hide and show subtopics, you can hide and show notes text. Just click on the Show/Hide Note button or double-click the outlined + or - next to the topic.

Moving topics around

Inspiration has lots of ways to organize your topics. One of the easiest is to drag topics and place them where you want them. Here, you will move Sarah so that it appears above Mom.

1 Select the topic Sarah by clicking to the left of the topic prefix.

2 Hold the mouse button down and drag the topic, Sarah, up in your outline until it covers the topic Mom.

[image: image19.png]Family Vacation
1.+ What we want to do
[ &) Mom

.- Swim

P

3. - Scuba
B.+Dad

1. - Play golt

2.+ Fish

a)
1. = Snorkeling

farlin





3 When the dotted rectangle covers the topic above which you want to insert Sarah, release the mouse button. Sarah and its subtopic and notes appear above Mom and below What we want to do on the outline.

Changing the prefixes for your outline

Everyone has preferences about how things look. For example, you may want to change the kind of prefixes that appear in front of the topics on your outline. It is easy to do. Here we’ll change from Roman Numeral (the way prefixes are when you first start Inspiration) to an alphanumeric set of prefixes.

1 On the Outline toolbar, click the Prefix button, then choose AlphaNumerals.

Inspiration changes all the prefixes on your outline.

Aside… You can globally change topic fonts and styles as well as set margins, headers and footers using Outline Properties. You can access Outline Properties by choosing Outline Properties on the File menu.

Printing your outline

When you print your outline, Inspiration automatically includes all topics, subtopics and notes text. Inspiration also prints a header at the top of each page. Of course, you can change what is to appear in the header or choose to print no header by changing the settings in the Outline Properties dialog box. You can preview what your outline is going to look like, and then print it.

1 On the File menu, choose Print Preview.

Your outline appears onscreen so you can see how it will look on the page.

2 To print your outline, click Print. If you do not want to print your outline, click Cancel to return to the Outline view.

3 When the Print dialog box appears, click (OK). Your outline prints.

Return to Diagram view

Now let’s return to Diagram view so you can embellish what you’ve created. When you return to Diagram view, you will find that the symbols have changed to reflect the work you did in Outline view.

1 While you’re still in Outline view, select the topic Snorkeling so that it will be selected and you can find it quickly when you return to Diagram view. If the Snorkeling topic isn’t showing on the screen, press (Ctrl+M) to select the Main Idea and show the top portion of your outline in the window. You can then select Snorkeling.

2 To return to Diagram view, click the Diagram button on the Outline toolbar.[image: image20.png]
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You can see that the new topics you added in Outline view, like Snorkeling, appear as idea symbols.

Working with notes text in Diagram view

In Diagram view, notes text is stored in separate notes windows attached to idea symbols. Every idea symbol can have notes text. You can open a notes window at any time to write, to modify your notes and to read what you’ve written.
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1 To display the notes text for Snorkeling, on the Diagram toolbar, click the Add Note button.[image: image23.png]



The notes window opens and the note you wrote earlier appears. At this point, you can add to or edit your notes, if you want. Just click in the notes text window where you want to begin and start typing, or select the words you want to replace and type over them.

2 When you’re ready to close the notes text window, click the Close box on the notes text window or, on the File menu, choose Close.

Changing the font used for your idea symbols

You will want to use your favorite font in your idea symbols. Let’s select all the symbols and change the font.

1 To select all the symbols on your diagram, on the Edit menu, choose Select, then choose Symbols.

2 On the Format menu, choose Font, then select the font you’d like to use. The text in all the idea symbols changes to the new font.

Setting up the default look for new symbols

Now that we have changed the way your idea symbols look, we can tell Inspiration to use this look for all new symbols we create. Let’s start by selecting the idea symbol Play golf. It already has the shape and the new font we want to use. Then we’ll set that as the new look so that the symbol’s characteristics will appear automatically whenever we create a new symbol.

1 Click the idea symbol Play golf to select it.

2 On the Diagram toolbar, click the New Look button.[image: image24.png]



Inspiration sets the new look and shows you a preview.

Add a new symbol with the new default look

We will add a new symbol off the Main Idea symbol, Family Vacation. First we’ll select the Main Idea symbol, then create the symbol.

1 On the keyboard, press (Ctrl+M) to select the Main Idea symbol, Family Vacation.

2 On the Diagram toolbar, position the pointer over the Left arrow on the Horizontal and Vertical Create button.

3 Click the Left arrow to create a new symbol to the left of Family Vacation.

4 Type Possible places and click outside the symbol to deselect it. You will notice the new symbol has the new default attributes.

Arranging your diagram into a tree chart

The Arrange tool lets you change your diagram into various kinds of tree charts. We’ll use the Arrange tool to change the format of the diagram from a cluster to a top down tree chart.

1 On the Diagram toolbar, click the Arrange button. The Arrange dialog box appears.

2 Review the selections in the dialog box. You’re going to use these default settings:

• Under Diagram Type, Top Down Tree is selected.

• Entire Diagram is selected.

• In the Links drop-down list, Auto-90 is selected.

• Under Lowest Level Stacking Models, No Stack is selected.

3 Click OK.

Inspiration arranges the diagram with the Main Idea symbol at the top, and the remaining idea symbols in order beneath it.

Resize the diagram so it fits in the window

Let’s change the view scale so that we can see the entire diagram in the window.

1 On the scroll bar at the bottom left of the window, click the Percentage box to the left of the Zoom buttons, then select Fit To Window.

Using color

You can further customize your diagram by changing the color of symbols, links and text. Just select the item whose color you want to change, then click the appropriate color button on the Draw toolbar — Fill Color, Line Color or Text Color.

Change a symbol to a multicolor symbol shape

1 Click the Sun symbol to select it.

2 On the Symbol palette, click the sun symbol in the Basic library.
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The Sun symbol on your diagram changes to the sun shape.

Change the colors of the multicolor symbol

1 Click the Sun symbol to select it.

2 Click the Multicolor button on the Draw Toolbar, and then choose colors you want from the palette.

[image: image26.png]



Try changing the black areas of the sun to a light orange to give the sun a warm glow.

You’ve finished your diagram!

Congratulations. You’ve finished creating your Family Vacation diagram. Let’s take one more look at how your diagram appears on the screen.
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Previewing and printing your diagram

1 First preview your diagram. On the File menu, choose Print Preview.

Inspiration shows you what your printed page will look like so you can return to your diagram and make adjustments if you wish.

2 In the Print Preview window, click Print.

3 In the printer dialog box for your printer, make your choices, then click (OK). When you print diagram, the notes text for your diagram prints as a separate document after your diagram prints.

Close Inspiration

You’ve now had a quick introduction to some of Inspiration’s features. You can create a diagram and work on your outline, change the look, move things around, and lots more.

1 On the File menu, choose (Exit).

Inspiration asks whether you want to save your changes.

2 Click Yes to save the sample document or No to close Inspiration without saving the document.

Terrific work!!
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